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Chapter 13
Flexible Molecules

This chapter describes procedures available for calculations on 
flexible molecules.  

Up to this point, we have not paid much attention to the different 
conformers that molecules might adopt. Many of the molecules 
dealt with so far are rigid or dominated by a single conformer and, 
where they are not, we have chosen to downplay the importance of 
conformation. In fact, the vast majority of molecules are not rigid 
and knowing the “right” conformer or conformers can be important 
to properly describing molecular spectra and properties and overall 
chemical behavior.

The five tutorials in this chapter illustrate a variety of approaches for 
dealing with flexible molecules. The first tutorial presents a molecule 
with only a single degree of (conformational) freedom. Here the 
focus is not only on identifying the “best” conformer, but also on 
rationalizing why it is the best. The second tutorial explores a molecule 
with two degrees of freedom. The focus here is on identifying all 
“reasonable” conformers and comparing the ordering of energies for 
these conformers with different theoretical models. The third tutorial 
involves a molecule with several degrees of conformational freedom 
and hundreds of conformers. Its goal is simply to find the lowest-
energy conformer using practical methodology. The last two tutorials 
have more of a chemical focus. The first of these asks a question 
about the “price” that needs to be paid in order for a molecule to be 
properly oriented for an intramolecular reaction. The second asks a 
similar question, but this time with regard to a proper conformation 
for binding to a protein.
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25 mins

Internal Rotation in Dimethylperoxide

OO
CH3

CH3

Quantum chemical calculations may be called on to furnish data 
to parameterize empirical energy functions for use in molecular 
mechanics and/or molecular dynamics calculations. Perhaps most 
important are data relating to torsional motions where small changes 
torsional angles may lead to large changes in overall shape, as well 
as significant changes in molecular spectra and properties. 

Any function chosen to represent the energy of rotation about a single 
bond needs to reflect the inherent periodicity, that is, it must repeat 
itself in 360°. The most common choice is a truncated Fourier series.

Etorsion (ω)  =  ktorsion1 (1 - cos(ω - ωeq))  + ktorsion2 (1 - cos2(ω - ωeq))
+  ktorsion3 (1 - cos3(ω - ωeq))

Here, ω­eq is the ideal dihedral angle and ktorsion1, ktorsion2 and ktorsion3 
are parameters. The first (one-fold) term accounts for the difference 
in energy between syn and anti conformers, the second (two-fold) 
term for the difference in energy between planar and perpendicular 
conformers, and the third (three-fold) term for the difference in energy 
between eclipsed and staggered conformers. 

In this tutorial, you will examine the energy for rotation about the 
oxygen-oxygen bond in dimethylperoxide, first using wB97X-D/6-
31G* density functional calculations to establish geometry and then 
using wB97X-V/6-311+G (2df,2p)[6-311G*]calculations to get a more 
accurate account. Both wB97X-D and wB97X-V functionals account 
for long-range dispersive interactions, the former by an empirical 
correction and the latter more properly by explicit calculation. The 
6-311+G(2df,2p) basis set is much more flexible than 6-31G*, but 
the calculation can be simplified using the so-called dual-basis set 
approximation where convergence is first reached with the smaller 
6-311G* basis set. You will fit your data to truncated Fourier series.
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1.	 Build dimethylperoxide. If the molecule is not already in an anti 
conformation, select Measure Dihedral from the Geometry 
menu ( ), click on COOC atoms in order, click inside the box 
to the right of Dihedral... and enter 180 (180°) using the number 
pad that appears. Do not minimize.

2.	 Select Constrain Dihedral from the Geometry menu ( ). 
Select the COOC torsion (click on COOC atoms in order), and 
then click on  at the bottom right of the screen. The icon 
will change to  indicating that a dihedral constraint is to be 
applied. 

3.	 Check the box to the left of Profile at the bottom right of the 
screen. This will result in two additional text boxes.

	
	 Leave 180° in the original (leftmost) box alone, but change the 

value in the box to the right of to to 0°. Click inside the box and 
enter 0 using the number pad. Steps should be 10. If it is not, 
click inside the box and enter 10 using the number pad. What 
you have specified is that the dihedral angle will be constrained 
first to 180°, then to 160°*, etc. and finally to 0°. Click on . 

4.	 Select Calculations... from the Setup menu ( ) and specify  
Energy Profile from the top menu to the right of Calculate, 
and Density-Functional, wB97X-D and 6-31G* from the 
three bottom menus. Click on Submit and accept the name 
dimethylperoxide.

5.	 When the calculations have completed (several minutes), they 
will go into a file named dimethylperoxide.Prof.M0001. A 
prompt will ask you if you want to open this file. Click on OK. 
Align the conformers. Select Align from the Geometry menu 
( ), select Structure from the Align by menu at the bottom 
right of the screen and, one after the other, click on both oxygens 
and on one of the carbons. Then click on the Align by button 
at the bottom right of the screen. Select Spreadsheet from the 

* The difference between constraint values is given by: (final-initial)/(steps-1).
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Display menu ( ), and enter both the energies relative to the 
180° conformer, and the COOC dihedral angles. First click 
on the label (M0001) for the top entry in the spreadsheet (the 
180° conformer), then click on the header cell for the leftmost 
blank column, and finally, click on Add... at the bottom of the 
spreadsheet. Select rel. E (kJ/mol) from the quantities in the 
Molecule List tab, and click on the spreadsheet to release the 
dialog. To enter the dihedral angle constraints, select Constrain 
Dihedral from the Geometry menu ( ), click on the constraint 
marker attached to dimethylperoxide and click on  at the 
bottom of the screen (to the right of the value of the dihedral 
angle). Click on .

6.	 Select Plots from the Display menu ( ). Click on  
at the top of the (empty) plot pane and select  Constraint(Con1) 
from the X Axis menu and rel. E(kJ/mol) from the Y Axes list 
and then click Create.

	
	 To fit the points to a Fourier series, click on  at the top of the 

plot pane, select Fourier to the right of Curve in the resulting 
dialog and click on Done.
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7.	 To get a better account of the energy profile for rotation about 
the OO bond in dimethylperoxide, perform calculations with 
the wB97X-V/6-311+G (2df,2p)[6-311G*] density functional 
model* (using the equilibrium geometries that you obtained 
from the wB97X-D/6-31G* model). First, make a copy  
of dimethylperoxide.Prof.M0001. Name it dimethylperoxide 
wB97X-V. Select Calculations... from the Setup menu ( ) 
and specify calculation of energy using the wB97X-V/6-311+G 
(2df,2p)[6-311G*] density functional model. Make certain that 
Global Calculations (at the bottom of the dialog) is checked 
to signify that energy calculations are to be performed on all 
conformers. Click on Submit.

8.	 Energy calculations for all ten conformers will require several 
minutes to complete. When they are done, draw a new energy 
plot and compare it to the energy plot produced earlier.

9.	 Close all documents and dialogs. 

* This is different from the model provided in SSPD in that it employs the dual basis set 
approximation where 6-311G* is the supporting small basis set. Use of the dual basis 
set approximation leads to an order of magnitude reduction in cost with little noticeable 
difference in relative conformer energies.
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30 mins

Ethinamate

O
O
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Ethinamate is a prescription drug previously used for the treatment 
of insomnia. It involves two degrees of conformational freedom, 
rotation of the single bond to the carbonate group (two unique 
arrangements) and inversion of the six-member ring (two unique 
chair conformers).

1.	 Build or sketch ethinamate. Click on . Select Calculations... 
from the Setup menu ( ) and request a Conformer 
Distribution with the wB97X-V/6-311+G (2df,2p)[6-311G*] 
density functional model using wB97X-D/6-31G* geometries. 
This actually invokes a multistep recipe starting from a 
systematic conformer search using MMFF molecular mechanics 
and proceeding through several immediate steps to gradually 
reduce the number of conformers for the final energy calculation. 
Click on Submit, and accept the name ethinamate.

2.	 The calculation will require several tens of minutes. When it 
completes, ethinamate will display the lowest-energy conformer 
but the total energy, dipole moment and Mulliken atomic charges* 
will refer to a Boltzmann weighted average over all accessible 
conformers. A Spartan document containing these conformers 
(ethinamate_1) has been returned. Open the latter document, 
enter the total energies into the spreadsheet. You will see that 
the total energy of the best conformer is in fact lower than that 
of the Boltzmann averaged value (found in ethinamate).**

5.	 Close any open documents and dialogs.

* Natural charges are available only for the 6-311+G(2df,2p) basis sets. Electrostatic charges 
are too costly to calculate for molecules with large numbers of accessible conformers and 
are deliberately excluded.

** This may be surprising but is necessarily the case as the Boltzmann average while dominated 
by the lowest-energy conformer includes contributions from higher energy conformers.
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5 mins

Allyl Vinyl Ether
O

The Equilibrium Conformer and Conformer Distribution 
selections under Calculations in the Setup menu directly access 
the MMFF molecular mechanics model and either the wB97X-V 
or B97M-V density functional models with the 6-311+G(2df,2p)
[6-311G*] basis sets. They represent the extremes in terms of cost 
computation and are intended to be used in two situations with entirely 
different expectations. There are numerous models and combinations 
of models in between and the purpose of this tutorial is to explore 
one of them. Here we seek a semi-quantitative account of the energy 
required to go from the “best” conformer of a molecule to a conformer 
poised for chemical reaction. This is different than the expectation 
of the following tutorial which is to accurately account for the NMR 
spectrum of a flexible molecule.

Allyl vinyl ether undergoes Claisen rearrangement, the mechanism 
presumes a chair arrangement of the reactant. 

O O

O

‡

Is this the lowest-energy conformer (global minimum) or is additional 
energy required to properly orient the molecule for reaction? To find 
out, you need to locate all the conformers of allyl vinyl ether, identify 
the best chair structure and evaluate its energy relative to that of the 
actual global minimum. You will first carry out a conformational search 
using the MMFF molecular mechanics model, and then refine relative 
conformer energies using single-point wB97X-D/6-31G* density 
functional calculations based on 3-21G Hartree-Fock equilibrium 
geometries. The results are not expected to be as good as those 
that might be obtained from better geometry and especially energy 
calculations, but they should be sufficient for the objective at hand.
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1.	 Either build  or sketch  allyl vinyl ether.

2.	 Select Calculations... from the Setup menu ( ) and specify 
Conformer Distribution from the top menu to the right of Calculate 
and Molecular Mechanics and MMFF from the two bottom 
menus. Click on Submit and accept the name allyl vinyl ether.

3.	 When completed, it will give rise to a series of low-energy 
conformers* placed in a new file allyl vinyl ether.Conf.M0001.** 
A prompt will ask you if you want to open this file. Click on 
OK.*** Select Spreadsheet from the Display menu ( ). Size 
the spreadsheet such that all rows (corresponding to different 
conformers) are visible at one time. Click on Add... at the bottom 
of the spreadsheet. Click on the E (kJ/mol) button from the 
Molecule tab and click on the spreadsheet to remove the Add 
dialog. Energies for each of the different conformers will be 
added to the spreadsheet. Examine the lowest-energy conformer 
(the top entry). Is it in a chair conformation suitable for Claisen 
rearrangement? If not, identify the lowest-energy conformer that 
is suitable. You can keep two or more conformers on screen at 
the same time by checking the boxes immediately to the left of 
the molecule labels (the leftmost column) in the spreadsheet. To 
get a clearer idea of structural similarities and differences, align 
the conformers. Select Align from the Geometry menu ( ) and 
select Structure from the Align by menu at the bottom right of 
the screen. A message will appear at the bottom left of the screen.

	
	 Click on oxygen and on the two carbons of the vinyl group 

bonded to oxygen to designate them as alignment centers. Each 
will be marked by a red circle. If you make a mistake, click on 
the circle and it will disappear. When you are done, click on the 
Align by button at the bottom right of the screen. Click on .

* By default, only conformers within 40 kJ/mol of the global minimum will be kept. This can 
be changed (see Conformational Search in Appendix D).

** M0001 is the default label of the molecule you built. You can change it by altering the Labels 
field in the Molecule Properties dialog (Properties under the Display menu; Chapter 22).

*** To avoid confusion, it is a good idea to close the original file allyl vinyl ether.
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4.	 To obtain a better estimate of the energy required to twist allyl 
vinyl ether into a conformer suitable for Claisen rearrangement, 
perform wB97X-D/6-31G* energy calculations using 3-21G 
geometries. Select Save As from the File menu ( ) to make a 
copy of allyl vinyl ether.M0001. Name it allyl vinyl ether density 
functional. Using the copy, delete all conformers except the 
global minimum and the lowest-energy conformer that appears 
to be most closely poised for Claisen rearrangement. Select each 
conformer to be discarded, and then select Delete Molecule 
from the File menu ( ). Alternatively, click on the cell in the 
spreadsheet containing the label for the molecule to be deleted, 
and then click on Delete at the bottom of the spreadsheet. When 
you are done, the spreadsheet should contain only two entries. 

5.	 Select Calculations... from the Setup menu ( ) and specify an 
Energy calculation and wB97X-D Density Functional method 
with the 6-31G* basis set. Also, specify Hartree-Fock and 
3-21G from the Start from menu. Make certain that Global 
Calculations at the bottom of the dialog is checked to specify that 
the dialog settings apply to both conformers. Click on Submit.

6.	 When completed, examine the conformer energies. Select 
Spreadsheet from the Display menu. Click on the Add button 
at the bottom of the spreadsheet and click on the rel.E (kJ/mol) 
button from the Molecule List tab. Click on the spreadsheet to 
release the Add dialog. What is the energy needed to go from 
the global minimum to a conformer poised to undergo Claisen 
rearrangement?

7.	 Close all open documents and dialogs.



204	 Chapter 13

2 hours

13C Chemical Shifts Depend on Conformation

At normal temperatures, the time for nuclear spin relaxation is very 
long relative to time required for equilibration among conformers. 
This means that for each of the carbon chemical shifts in the NMR 
spectrum of a flexible molecule, 13C, will be a weighted  average of 
the shifts NMR of the individual conformers,13Ci.

13C = Σi ωi
13Ci

The weight, ωi, is given by the Boltzmann equation, and depends on 
its energy, εi (relative to that of the lowest-energy conformer, ε0) and 
on temperature, T. Summation is over all conformers (including the 
lowest-energy conformer), gi is the number of times that conformer i 
appears in the overall distribution and k is the Boltzmann constant.

ωi = gi exp - [εi - ε0/kT]/Σj {exp - [εj - ε0/kT]}

In practice, conformers that are 10 kJ/mol or more above the lowest-
energy conformer make a negligible contribution to the total (at room 
temperature). However, in order to actually know which conformers 
are important and to construct a proper Boltzmann average, it is 
necessary to examine all of them.

In this tutorial, you will use the protocol first introduced with 
Spartan’18 to calculate the 13C NMR spectrum of limonene. This 
comprises two parts, the first a multi-step protocol starting from 
MMFF molecular mechanics and ending with a series of large basis 
set density functional calculations to obtain “accurate” Boltzmann 
weights, and the second a set of small basis set density functional 
calculations to obtain 13C chemical shifts. The two parts are then 
combined to produce a Boltzmann averaged 13C spectrum.

1.	 Build or sketch limonene.
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2.	 Enter experimental 13C chemical shifts (shown above) either 
on the sketch or 3D model. If you choose to add to the sketch, 
select Edit Sketch ( ) from the Build menu and then click on 
(1H/13C) from the row of icons above the sketch pad. Click in turn 
on each carbon, click inside the box that appears to its right, use 
the number pad that comes up to type in the chemical shift and 
click on Enter. If you choose instead to add to the 3D model, 
select Expt. Chem. Shifts [1H/13C] from the Expt. Data menu. 
As with the sketch, click in turn on each carbon, click inside the 
box that appears to its right, use the number pad to type in the 
chemical shift and click on Enter.

3.	 Select Calculations... from the Setup menu, NMR Spectrum 
(Density Functional)*, wB97X-D and (6-31G*)* from the 
top three menus to the right of Calculate and wB97X-V/ 
6-311+G(2df,2p)[6-311G*] Weighted Average and wB97X-D/ 
6-31G* from the bottom two menus. Click on Submit.

4.	 The calculation may require an hour or more.** When completed, 
bring up the Properties dialog (Display menu) and click on the 
NMR tab. Statistics related to the fit between calculated and 
experimental 13C shifts are provided on the left at the center of the 
dialog that results, specifically RMS, Max Absolute and Mean 
Absolute errors. If the Boltzmann Average tab is checked, these 
correspond to a Boltzmann weighted average over conformers. 
If the Best Fit tab is checked, they instead correspond to the 
conformer which best fits measured values. You will see that 

* Pre-selected menu items cannot be altered.
** If you don't want to wait, a pre-calculated file is available. For Windows, this directory is 

found in Program Files/Wavefunction/Spartan20. It must  be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level of the Spartan’20 
disc image.
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both measures provide good concurrence between calculated 
and measured 13C chemical shifts.

Spartan provides two different ways to assess the fit between 
calculated and measured 13C chemical shifts. The first and clearly the 
more rigorous measure involves constructing a proper Boltzmann-
weighted average. This requires accurate conformer energies and 
associated Boltzmann weights which in turn functionals that take 
proper account of long-range interactions such as the wB97X-V 
functional and large basis sets such as 6-311+G(2df,2p). While 
such an approach can be applied to medium-size organic molecules 
with moderate conformational flexibility, it can involve many hours 
of computer time. The second approach only requires that a set of 
“good” conformers be identified, and from among these selects 
the conformer 13C chemical shifts for which best fit measured 
values. Lacking the need for accurate Boltzmann weights, it can 
rely on simpler functionals such as wB97X-D where long range 
interactions are dealt with empirically and smaller basis sets such 
as 6-31G*, and as a result, is an order of magnitude faster.

5.	 The structure that has been returned corresponds to that with 
the lowest wB97X-V/6-311+G(2df,2p)[6-311G*] energy (the 
leading contributor in the Boltzmann average). A secondary 
file, limonene_Conf, has been created (but not opened). This 
contains NMR chemical shift calculations for all conformers.

6.	 Close any open documents and dialogs.



Chapter 13	 207
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Gleevec. Protein Bound vs. Free Conformer

gleevec
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Gleevec (Glivec, Imatinib) is a protein kinase inhibitor used in 
anticancer therapy. It specifically targets a protein kinase coded for in 
the rogue gene bcr-abl. Several crystal structures for gleevec docked 
in protein kinases are available in the PDB. In this tutorial, you will 
examine one of them* to establish whether or not the conformation of 
gleevec in the protein is identical (or similar) to that of the free (gas-
phase) molecule, and if not, what energy penalty is to be paid to adopt 
the protein-bound conformation. The next tutorial will return to this 
same structure and extract a pharmacophore (gleevec’s footprint).

1.	 Retrieve a protein structure from the PDB. Select Access PDB 
Online... from the File menu ( ). Type 1opj into the box to 
the right of PDB ID and click on Open.

If you are not online, you may skip this step as the structure is 
available as 1opj in the medicinal chemistry sub-directory 
(tutorials directory).**

	 The protein will be represented by a ribbon model. Red  sections 
correspond to parts of the chain that are a helices, while blue 

* B. Nager et al,  Cell, 112, 859 (2003): PDB identification 1opj.
** For Windows, this directory is found in Program Files/Wavefunction/Spartan20. It must  

be copied to another location available to the user prior to opening it in Spartan. For Linux, 
this is found in the directory where Spartan was installed. For Macintosh, this is located at 
the top level of the Spartan’20 disc image.
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regions correspond to parts that are b sheets (the remaining 
regions are green). A Ramachandran plot (the f and y torsional 
angles connecting the individual amino acids) allows you to 
see the clustering of a helices and b sheets. To display, select 
Ramachandran Plot from the Model menu ( ). The colors 
of the dots in the resulting plot map one-to-one with the colors 
of the ribbon model. When you are done, click on  to remove 
the plot.

The colors on the ribbon display may be modified, by selecting 
Configure... from the Model menu ( ) and clicking on the 
Ribbons tab. Coloring By Residue will give each amino acid its 
own unique color.

	 The protein you have brought in from PDB incorporates two 
sets of bound molecules, depicted in the model as two sets of 
translucent spheres. Gleevec is the larger of the two incorporated 
molecules and is designated by its PDB HET code STI.

2.	 Select Extract Ligands from 
the File menu ( ). Select (click 
on) one of the gleevec molecules 
inside the protein structure and 
click on the Extract Ligands 
button at the bottom right of the 
screen. This leads to the Extract 
Ligands dialog. 

	 Check Ligand Structures under Include and Grow Hydrogens 
under Extraction Filters inside the dialog (if other options are 
selected, remove them) and click on OK.

3.	 A ball-and-spoke model for gleevec will appear on screen. (You 
no longer need the protein; select and close it.) Put a copy of 
gleevec on the clipboard. With the molecule selected, choose 
Copy from the Edit menu or right click on the background and 
select Copy from the menu that appears.

4.	 Select Build New Molecule (not New Build) from the File 



Chapter 13	 209

menu ( ). Select Clipboard from the organic model kit and 
click anywhere on screen. Click on . You now have two 
copies of gleevec in a single document. You can step between 
them using the step buttons at the bottom left of the screen.

5.	 Select the first copy and then select Calculations... from the 
Setup menu ( ). Equilibrium Geometry from the top left 
menu to the right of Calculate and Molecular Mechanics and 
MMFF from the two bottom menus. The conformation will not 
be altered, but bond lengths and angles will be optimized. 

Structure optimization is necessary in order to establish the 
energy difference between protein-bound and free conformations 
of gleevec. The resolution of protein X-ray crystallography is 
not adequate to establish bond lengths and angles to chemical 
accuracy.

	 Remove the checkmark from Global Calculations at the 
bottom of the dialog to signify that your choice (geometry 
optimization) only applies to this copy of gleevec. Click on OK 
(not on Submit).

6.	 You will use the second copy of gleevec as a starting point 
for a conformational search. First, remove some degrees of 
conformational freedom in order to shorten the computer time 
for the conformational search. With the second copy, select 
Set Torsions from the Geometry menu ( ). Your model will 
be augmented with yellow cylinders and circles to designate 
flexible bonds and rings, respectively. Remove the markers 
(circles) on the piperazine ring by double clicking on each in 
turn. The conformation of the piperazine ring will not change 
during the search. The model should now appear as below.
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7.	 Select Calculations... from the Setup menu ( ). Select 

Equilibrium Conformer from the top left menu to the right of 
Calculate and (as before) Molecular Mechanics and MMFF 
from the two bottom menus. Click on Submit, and provide the 
name gleevec protein bound vs. free conformer.

8.	 When the calculations have completed (perhaps minutes), 
select Spreadsheet from the Display menu ( ). Click inside 
leftmost the cell for the second molecule (the one on which 
a conformational search was performed) then click inside the 
header cell for a blank data column. Click on Add at the bottom 
of the dialog and select Rel. E from the scroll box in the dialog that 
appears and kJ/mol from the Energy menu. The relative energy 
of the protein bound conformer is provided in the spreadsheet. 
Is it close to zero meaning that the protein-bound conformer will 
be present in significant amount in a sample of free gleevec?

9.	 Close gleevec protein bound vs. free conformer and any open 
dialogs.
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15 mins

HMBC Spectrum of Cantharidin

Cantharidin provides a very simple example for the way in which an 
HMBC spectrum is set up and displayed and the results compared 
with assigned experimental CH couplings. The molecule is rigid 
eliminating concerns about conformation and its structure has been 
confirmed by X-ray crystallography.

1.	 Build or sketch cantharidin. Enter both experimental proton 
and 13C chemical shifts as shown below (the 1.24 in parenthesis 
following the 13C shift of 12.7 for the C10 and C11 are the 
associated proton shifts).*

	
2.	 In 3D mode, select Expt. Chem. Shifts from the Expt Data 

menu or click on each chemically unique carbon and hydrogen, 
click on Edit to the right of Expt. Chem. Shifts at the bottom 
right of the screen, type in the chemical shift in the number pad 
and click on Enter.

3.	 Observed 2 and 3-bond CH couplings are as follows (see 
numbering above):

	 H6	 C4, C5, C7, C9

	 H6a	 C5, C6, C7

	 H7b	 C5, C6, C7

	 H10	 C2, C4, C9

* Experimental data from: D. Sicker, K-P. Zeller, H-U Siehl and S. Berger, Natural Products, 
Isolation, Structure Elucidation and History, Wiley -VCH, Wenheim, Germany, 2018.
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	 In 3D mode, select CH Couplings from the Expt. Data menu 
or click on [JCH]. Clicking on one of the four hydrogens noted 
on the previous page, for example H6 will result in all carbons 
where 2 or 3-bond CH coupling might be observed being 
highlighted. Click on one of these, C4, C5, C7 or C9, in this 
example, will draw an arrow from hydrogen to carbon. Click 
again on the same hydrogen to specify the couplings for the 
other carbons. Repeat for the remaining hydrogens. Your 3D 
model (tube representation) should look as follows.

	
4.	 Cantharidin is rigid, so the multi-step procedure involving 

different possible conformers is not necessary. Select 
Calculations from the Setup menu and specify calculation 
of equilibrium geometry using the wB97X-D/6-31G* model. 
Check NMR to the right of Compute and select Calculated 
(Fermi Contact) from the menu to the right of Coupling 
Constants. You have requested both chemical shifts and 
coupling constants to be calculated, the latter using the so-called 
Fermi contact approximation. This is nearly as accurate and 
significantly faster than the full coupling constant calculation. 
Click on Submit. 

5.	 When the job completes (a few minutes), select Spectra 
from the Display menu (or click on ), click on  at the 
top left of the spectra display that occupies the lower half of 
the screen and select . Click again on  and select 

. Calculated and experimental HMBC spectra will be 
superimposed and appear at the center of the spectra display area. 
Click on  to bring them onto the main screen and then click 
on  at the top right of the spectra display area to dismiss it.
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6.	 Expand the spectra on the main screen by first clicking on either 
the left vertical axis (13C) or the bottom horizontal axis (1H) 
and then using the scroll wheel. Alternatively, on touch screen 
devices, pinch your fingers together after selecting an axis. The 
scale of the 13C axis (0 - 200 ppm) is OK, but change the proton 
axis to range from 0 - 5 ppm. Click on the axis to select and 
enter 5 to replace the default value of 10 ppm and press Enter. 
The HMBC plot should appear as follows.

	

	 The crosses represent experimental couplings and the open 
circles calculated couplings. Orange circles designate 3 bond 
couplings and magenta circles designate 4-bond couplings. 
You can see details (proton and 13C chemical shifts in ppm and, 
in the case of calculated values, coupling constants in H3) by 
clicking inside the circles or at the center of the crosses.

7.	 Close all open files and dialogs.
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5 hours

Linalool: Calculating the NMR Spectrum of a Flexible Molecule

Spartan provides two different pathways, each supported by an 
automated multi-step protocol, for calculating proton and 13C spectra 
as well as 2D COSY and HMBC spectra of flexible molecules. The 
more rigorous and more costly in terms of required computation 
involves construction of a proper Boltzmann-weighted average, 
in practice, calculation of accurate Boltzmann weights for all 
accessible conformers followed by calculation of chemical shifts 
and (optionally) coupling constants for each of the conformers. 
Boltzmann weight calculation is the limiting step as it requires 
density functional models that account explicitly for long-range van 
der Waals or dispersive interactions coupled with large basis sets. 
Calculations of moderate size (MW in the range of 500 amu) with 
100 or more conformers can easily consume many hours on present 
generation personal computers.

The second less costly and less rigorous approach replaces the 
need for accurate Boltzmann weights with the less demanding task 
of identifying the low-energy conformers and then choosing from 
among these conformers the one that best fits the experimental 
NMR data. Of course, this requires that the experimental data exist! 
Simpler density functional models with much smaller basis sets are 
suitable. 

In this tutorial, you will calculate 13C chemical shifts for the natural 
product linalool using the simpler procedure and compare results 
both to experimental values as well as those obtained from Boltzmann 
averaging. 

1.	 Build or sketch linalool. Enter the 13C shifts (see figure below). 
Select Expt. Chem. Shifts from the Expt. Data menu, click 
on each chemically unique carbon, click on Edit to the right of 
Expt. Chem. Shifts at the bottom right of the screen, type in a 
chemical shift using the number pad and click on Enter. When 
you are done, click on .
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2.	 Open the Calculations dialog (Calculations from the Setup 

menu) and select NMR Spectrum (Density Functional), 
wB97X-D and (6-31G*) from the four top menus to the right 
of Calculate and wB97X-D/6-31G* and 3-21G from the 
two bottom menus. This specifies calculation of energies and 
chemical shifts from the wB97X-D/6-31G* density functional 
model using Hartree-Fock 3-21G equilibrium geometries. Click 
on Submit.

3.	 The job will take several hours. When completed, bring up the 
NMR properties dialog (Properties from the Display menu and 
click on NMR). Click on the Best Fit tab at the center left of the 
dialog to see how well the calculated shifts fit the experimental 
data. RMS is perhaps the best measure where values less than 
or close to 2 ppm indicating a good match.

4.	 The calculation you performed selects the conformer that best 
fits the experimental NMR data rather than constructing a proper 
Boltzmann-weighted average. You can do the latter if you wish 
(it will require significantly more computer time) by changing 
the entries in the two bottom menus to the right of Calculate 
in the Calculations dialog to wB97X-V/6-311+G(2df,2p)
[6-311G*] Weighted Average and wB97X-D/6-31G*. When 
this job completes, you need to select the Boltzmann Average 
tab in the NMR properties dialog instead of the Best Fit tab. 
The errors should be identical or similar to:

	 RMS 1.88
	 Max Absolute 3.36
	 Mean Absolute 1.60

	 Both procedures provide a good description in this case.

5.	 Close any Spartan documents and open dialogs.
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1 hour

Anethole: Boltzmann Averaging 13C Chemical Shifts

The natural product anethole provides a very simple illustration of 
obtaining 13C chemical shifts as a Boltzmann-weighted average over 
different conformers.

The molecule is small and there are only two conformers, so the task 
can be completed using only a few minutes of computer time.

1.	 Build or sketch anethole. Enter 13C experimental chemical shifts 
(provided in the drawing above). Select Expt. Chem. Shift from 
the Expt. Data menu and in turn click on each unique carbon*, 
click on Edit to the right of Expt. Chem. Shift at the bottom 
right of the screen, use the number pad to enter the value of the 
shift and click on Enter.

2.	 Inside the Calculations dialog (Calculations from the Setup 
menu), select NMR Spectrum, (Density Functional), 
wB97X-D and (6-31G*) from the four top menus to the right 
of Calculate and wB97X-V/6-311+G(2df,2p)[6-311G*]
Weighted Average and wB97X-D/6-31G* from the two bottom 
menus. You have requested that Boltzmann weights be obtained 
in a multi-step procedure for the (two) conformers of anethole 
using the wB97X-V/6-311+G(2df,2p)[6-311G*]//wB97X-D/ 
6-31G* density functional model, and following this, chemical 
shifts for the conformers be calculated with the empirically 
corrected wB97X-D/6-31G* density functional model, allowing 
that the Boltzmann average to be obtained. Click on Submit at 
the bottom of the dialog.

* Spartan detects identical atoms (in this example the two carbons ortho and the two carbons 
meta) to the methoxy group. You only need to enter experimental data for unique atoms.
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3.	 When completed (probably 10-20 minutes), bring up the NMR 
properties dialog (Properties under the Display menu and click 
on the NMR tab. Make sure that Boltzmann Average tab (not 
Best Fit) tab is selected. The reported error statistics indicate 
an excellent fit of calculated to experimental 13C shifts.

4.	 Close any open Spartan documents and dialogs.

several hours

Ambiguine H. DP4 Analysis to Assign Stereoisomer

The structure assigned to the natural product ambiguine H is shown 
below. It contains four stereocenters, two of which designated R 
dictate the disposition of substituents attached to the incorporated 
trans-decalin bicyclic.

In this tutorial, you will use the DP4 metric to confirm or refute the 
experimentally assigned stereochemistry about these two centers. 
This involves chemical shift calculations on the four distinct 
structures each of which is conformationally flexible.

1.	 Build or sketch ambiguine H. To enter the experimental 13C 
chemical shifts, select Expt. Chem. Shift from the Expt. Data 
menu. Click on each carbon in turn, click on Edit to the right 
of Expt. Chem. Shift at the bottom right of the screen, use the 
number pad to type in a value and click on Enter.
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2.	 Rotatable bonds should be properly marked, but it is a good 
idea to check. Select Set Torsions from the Geometry menu. 
The three bonds shown in the figure below should be marked 
(encircled with yellow cylinders). If any are not, double click 
on the bond to select. If on the other hand, any other bonds are 
selected, double click to deselect.

		

3.	 Make a list of the four stereoisomers. Select Generate Isomers 
from the Geometry menu. In turn, click on each of the two 
stereocenters bearing substituents. They will be encircled in 
green (see figure below). Click on Generate list to the right of 
Isomers at the bottom right of the screen. Select New Document 
from the dialog that appears and click on OK. The four isomers 
(including the RR stereoisomer that you started with) will be 
placed in a new Spartan document. Click on Save (File menu) 
and name it ambiguine H isomers. It’s a good time to close the 
original document.
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4.	 Bring up the Calculations dialog (Calculations from the Setup 
menu) and select NMR Spectrum, (Density Functional), 
wB97X-D and 6-31G* from the four top menus to the right 
of Calculate and wB97X-D/6-31G* and HF/3-21G from the 
two bottom menus. What you have requested is done “under 
the hood” in two steps. First, NMR spectra for all conformers 
for each of the four stereoisomers are calculated, allowing the 
conformer for each isomer that best fits the experimental 13C 
chemical shifts based on its DP4 score to be identified. Second 
DP4 scores for this set of “best” are evaluated. Make certain 
that Global Calculations at the bottom of the dialog is checked 
before you click on Submit.

5.	 The job will take several hours to complete. It involves 
calculations on as many as 108 molecules (up to 27 conformers 
on each of the 4 stereoisomers). When it is done, bring up the 
NMR properties dialog (Properties under the Display menu 
and click on the NMR tab). Step through the four isomers and 
identify the one with the highest DP4 score. Is this the one that 
has been assigned based on its NMR spectrum? Are any other 
isomers competitive?

6.	 Close all open Spartan documents and dialogs. 

	


